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April 2014 - Letter from the Editor 
Welcome to the eleventh edition of the BetterSolutions.com newsletter. In this issue we are going to discuss 

Office Mobile, Office Online, Office 365, SUBTOTAL function, YIELD function and Macro Security. This issue 

was originally going to be dedicated to “What’s Changed in 2010/2013” but there have been so many changes 

we decided to put this information straight onto the website instead. Each section now includes a page called 

“Version Changes” which discusses what has changed in the context of that particular section. For example to 

see what changes have been made in relation to Excel Charts please refer to the (Excel > Charts > Version 

Changes) page. Every section also contains a page dedicated to Office Online articles. For Excel Functions this 

would be (Excel > Functions > Office Online). These online articles can no longer be accessed directly from the 

Microsoft website. The only other way to browse these pages is by pressing F1 from within your Office 

application. For the last couple of years we have been focusing on scalability and improving our infrastructure. 

Office 2013 offers even more features and combining this with Windows Phone and Office 365 we are very well 

positioned to give you all the support you need to be more productive. 

King of Spreadsheets 

Excel is the undisputed king of spreadsheets. 

The functionality is incredible, the 

integration is phenomenal and the 

customisation is endless. These spreadsheets 

can be used on any device and have a file 

format that is XML based and completely 

open. Our website demonstrates our 

commitment to Microsoft Office and has 

been designed to help you get the most from 

this application. If you want to be more 

productive, but don’t know where to go, 

maybe you should, visit our website: 

http://bettersolutions.com/excel.aspx 

support@bettersolutions.com 

This email address is the one you should use when you have any problems or questions with Microsoft Office 

and you want some FREE help and advice. Sending us your questions will not only mean that you get a reply 

immediately but will also allow us to publish the answer or solution in the next issue which will no doubt help 

other people as well. We spend a lot of time checking and testing the information to ensure that it is accurate 

but if you do spot any mistakes or anything that is not accurate then please tell us. We are always looking for 

ways to improve our products and services and always welcome constructive criticism. If you have any 

comments or suggestions regarding this newsletter and the content contained inside it please tell us. 

  

http://bettersolutions.com/excel.aspx
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News and Related Information 

What is Office Mobile? 

If you have a smart phone with a red office logo on it, this is 

Office Mobile. This has been designed specifically to work 

on smart phone devices This allows you to view and edit 

Excel, Word and PowerPoint documents from almost 

anywhere. It has been optimised for the Windows Phone 

but it also available on Android and iOS. Once installed you 

will be taken to the Office Hub which lets you access all your 

office documents. 

 

Excel Mobile lets you: view and edit formulas and basic worksheet functions; quickly view the sum, average, 

max, min and count from a range of cells; insert basic chart types (column, line, pie, bar, area, xy scatter); sort 

and filter tables of data (no merged cells); apply basic character formatting (bold, italic and underline); apply 

basic number formatting (dates, currency and percentage); view and edit comments; resize rows and columns 

and there is even a find box. It is not possible to add or remove worksheets, add or remove rows or columns or 

edit any advanced worksheet functions. 

 

Word Mobile lets you: highlight, copy and paste text; apply basic character formatting (bold, italic, underline, 

strikethrough, increase font, decrease font; insert comments; change font colours (orange, green, red); apply 

highlighting (yellow, green, red); outline view for navigation; insert emoticons and there is even a find box. It 

is not possible to undo, copy and paste graphics, cut/remove any text or graphics or apply styles or bullets. 

 

PowerPoint Mobile lets you: view and run slideshows (with animation); edit text inside placeholders; add notes; 

change the slide order and even hide individual slides. It is not possible to insert pictures, graphics, photos, 

movies or access the master slides. 

What is Office Online? 

Previously known as Office Web Apps. This is the term used for the browser versions of Microsoft Office. There 

are online versions of the following five applications: Excel, Word, PowerPoint, Outlook and OneNote. They 

can be used in most types of browser (including the latest versions of Firefox, Chrome and Safari). If you are 

using a machine that doesn’t have Office installed and you need to view, edit or transfer files then this can be 

easily done just using a browser. It is very easy to share files and collaborate with other users online. Multiple 

users can edit the same files at the same time and scrolling and searching is very fast. 

 

Excel Online lets you: collaborate on the same workbook simultaneously with other users; create charts and 

tables; access most of the worksheet functions; hide/unhide/insert and delete sheets, rows and columns; use the 

fill handle; formula bar; autocomplete; auto sum; hyperlinks; sort and filter data plus run your Apps for Office.  

 

Excel Online does not allow you to: view workbooks larger than 10MB; support VBA scripting; data validation; 

conditional formatting; what if analysis; replace functionality; advanced formula tools; insert comments; use any 

recommended charts or smart formatting. 
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What is Office 365? 

Office 365 is a subscription based version of Microsoft Office which includes SharePoint and Skype. Office 365 

can be used from any device (Smartphone, Browser, or Desktop) and integrates seamlessly with Office Mobile 

and Office Online. This subscription allows you to install the latest full versions on your desktop and updates 

are automatic so you will always have the latest version (with service packs). Internet access is required to install, 

activate and manage your 365 subscription account. Office 365 is available in over 40 different languages. 

 

Office 365 for professionals and small businesses gives you access to your email, important documents, contacts, 

and calendar from virtually anywhere on almost any device. This plan is ideal for organizations with fewer than 

25 employees that do not have dedicated IT staff. Office 365 for midsize businesses and enterprises is designed 

for organizations with advanced requirements. There are a number of different plans: 

 

365 Personal 2 devices per user Email, Skype, OneDrive and Office 365 ProPlus 

365 Home Premium 5 devices per user Email, Skype, OneDrive and Office 365 ProPlus 

365 Small Business 5 devices per user Email, Skype, OneDrive, Hosted SharePoint (no 

desktop versions) 

365 Small Business Premium 1 – 10 Employees 

5 devices per user 

Email, Skype, OneDrive, Hosted SharePoint and 

Office 365 ProPlus 

365 Midsize Business 11 – 250 Employees Email, Skype, OneDrive, Hosted SharePoint, 

InfoPath and Office 365 ProPlus 

365 Enterprise E Plans 250+ Employees Enterprise level features and support 

Office 365 ProPlus (subscription) 

This is a subscription based service that provides you with desktop versions of Excel, Word, PowerPoint, 

Outlook, OneNote, Publisher and Lync. It uses a Click-to-Run installation and provides updates automatically. 

Office 365 ProPlus is connected to the user and provides access from multiple devices concurrently. Keep older 

versions of Office side by side on your PCs to mitigate any potential file or add-in compatibility risks. It uses 

Office on Demand to cache updates in the background so the next time you close and re-open an application 

any updates are automatically installed. 

Office 2013 Professional Plus 

This is the conventional desktop versions of Excel, Word, PowerPoint, Outlook, OneNote, Publisher, Lync. It 

requires Windows Installer Package (MSI) installation and is directly connected to the hardware or device it is 

installed on. Any updates or service packs need to be installed manually. 

What is OneNote? 

OneNote is part of the Microsoft Office family and is a program for taking notes. Whether this is typed text, 

screen shots, photos, sketches or handwriting scribbles all this information is quickly and easily organised into 

pages and sections. You can also include different types of media (audio and video), hyperlinks, technical 

drawings, and presentations. Save any web page to OneNote and view it later, online or offline. You can share 

and edit the information simultaneously between multiple users on any device (including Mac). There is even a 

version of OneNote for Office Mobile so you can use it on your Smartphone. All your information is quickly 

accessible and editable. To find out more visit: http://onenote.com 

  

http://onenote.com/
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Ribbon Hero 2 (The Sequel) 

Ribbon Hero 2 is a sequel to Ribbon Hero (featured in our October 2010 newsletter). This learning add-in was 

created by Microsoft and has been designed to help people use Office 2010 and 2007. If you enjoyed playing 

Ribbon Hero 1 then you will love this version. It has lots of animations and graphics and feels even more like a 

game than a learning tool. Once installed you will see an additional group appear on the Home tab of the 

following applications: Excel, Word, PowerPoint and OneNote. The best thing about this version is that it 

features the office assistant Clippy (from Office 2003) and also includes a comic strip. Clippy travels to the Middle 

Ages, Ancient Greece, Renaissance Period and even the future. In each time zone, you must complete specific 

tasks before moving to the next one. Find out more at http://ribbonhero.com/ 

 

 

Channel 9 

This is a community site containing videos and tutorials on all the different Microsoft Office products. The site 

also contains discussions, screencasts and interviews. There is tonnes of useful information and there is even a 

Windows 8 app for quick and easy access. However if you just want to take a break from your work, check out 

the following link (very amusing): http://channel9.msdn.com/series/office 

Disclaimer 

Better Solutions Limited is in no way associated with Microsoft Corporation. All the content in this newsletter 

and on the website is provided “as is” with absolutely no warranties. We strongly recommend that you back up 

all your data first before installing any updates or third party software. In no event shall Better Solutions Limited 

be liable for any special, indirect or consequential damages whatsoever resulting from loss of use, data or profits, 

whether in an action of contract, negligence or other action arising out of or in connection with any information 

published in this newsletter or on our website. 

http://ribbonhero.com/
http://channel9.msdn.com/series/office
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Your Questions and Problems 
Excel – Why are my cells getting formatted automatically? 
Have you ever noticed automatic number formatting when you enter new data or create new formulas? It is a 

very subtle feature and most of us probably don’t even notice when it happens. This automatic formatting can 

appear in a number of different places. Sometimes it can be useful, other times it can be quite frustrating. The 

most annoying time though is when you use the Text to Columns feature or when data is imported into Excel 

from other systems and it automatically converts strings to dates. 

 

Example 1 - Text to Columns 
The way a date is displayed on a worksheet depends on the number format applied to that cell “before” the date 

is entered. When you type a string (that Excel thinks is a date) and the number format is “General” then the text 

string can be converted to a date (or time) automatically and the number format changes accordingly. The only 

official article that we found relating to this feature was Knowledge Base 214233. It states: 

“if a number contains a slash mark / or a hyphen -, it may be converted to a date format. If a number contains a 
colon : or is formatted by a space and the letter A or P, it may be converted to a time format” 
 

Let’s see an example, select cell “B2” and check that the number format is “General”. Type 09-01-26 into this 

cell and press Enter. Notice that it changes automatically to 09/01/2026. In fact what has actually happened is 

that the value has been automatically converted into a date and the number format has been changed 

accordingly. Select the Format Cells dialog box and you will see that the number format has been changed to 

“dd/mm/yyyy”. Even if you change the number format back to “General” or “Text” you cannot get back to your 

original string. The value remains 46031. 

 

 

 

 

 

There are a number of specific character combinations which Excel will translate into either a date or time. 

1/7 = 01-Jul (dd-mmm) 01-07 = 01-Jul (dd-mmm)  

01-07-11 = 01/07/2011 (dd/mm/yyyy) 1 Jul 26 = 01-Jul-26 (dd-mmm-yy)  

1-7 = 01 Jul (dd-mmm) 1/1/26 = 01/01/2026 (dd/mm/yyyy)  

Jul-1 = Jul-01 (mmm-yy)  12:25 = 12:25 ("hh:mm") 

12 A = 12:00 AM (h:mm AM/PM) 11 P = 11:00 PM (h:mm AM/PM) 

 

Example 2 - Worksheet Functions 
Automatic formatting can also appear when you use worksheet functions. There are a number of worksheet 

functions which, when used, will result in the number format of that cell changing automatically.  

 

 

 

 

 

 

 

Select cell “C2” and check that the number format is “General”. Type the formula “=DATE(2014,4,1)” and press 

Enter. Select the Format Cells dialog box and look at the number format. It has been changed to “dd/mm/yyyy”.
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Example 3 - Formulas 

Automatic formatting can also appear when you are using formulas. When you enter a formula into a cell which 

has the “General” number format. That number format is changed automatically to match the number format in 

the referenced cells. If your formula refers to multiple cells that have different number formats applied to them 

Excel will use its own rules to decide which number format to apply. Once a number format has been changed 

from “General” to something else, it will not be changed again. Changing the cell value or the number formatting 

of referenced cells will have no effect. 

 
Cell “B3” contains a date and has the number format “dd/mm/yyyy”. Cell “D3” contains a value and has the 

number format “General”. Select cell “F3” and check that the number format is “General”. Type the following 

formula “=B3+D3” and press Enter. Select the Format Cells dialog box and you will see that the number format 

has been changed to “dd/mm/yyyy”. There is no way of switching this feature off. Some more information can 

be found in the Knowledge Base 214233 article. 

 

Example 4 - VBA Code 
Automatic formatting can also occur when you populate cells using VBA code. When you type “01/07/2014” 

into a cell, this gets recognised as a date automatically and the number format gets changed to “dd/mm/yyyy”. 

You might expect the following two subroutines to give us the same result, but they don’t. In both of these 

situations a date is recognised but it is assumed that it has been entered in the US date format of “mm/dd/yyyy”. 

 

 

 

 

 

 

 

 

 

If you want to enter dates using VBA code then you need to convert the date to its date serial number first before 

adding it to the worksheet. Once the serial number has been added you can apply your date format. 
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Introduction to Smart Art 

SmartArt graphics are available inside the following applications (Excel, Word, PowerPoint and Outlook) with 

PowerPoint probably being the most used. These graphics can be used as visual representations for your 

information and ideas. To add a SmartArt graphic to your document select (Insert > SmartArt). There are over 

200 built-in layouts split across eight categories: List, Process, Cycle, Hierarchy, Relationship, Matrix, Pyramid, 

Picture and Office.com. Picture and Office.com were added in 2010. The amount of text and type of information 

that you want to display will influence which layout you choose. 

 
When you insert a SmartArt graphic the text pane should be displayed by default. You can quickly display or 

hide the text pane by clicking on the small arrow on the left hand side of the graphic. You can either type your 

text directly into the text pane or directly into the SmartArt object. As you edit the data in the text pane, the 

graphic is automatically updated. Shapes are added or removed as needed. Each SmartArt graphic defines its own 

mapping between the bullets in the text pane and the set of shapes in the SmartArt graphic. 

 

The text pane always appears to the left of your graphic and will resize 

automatically as the graphic is resized. At the bottom of the text pane, you 

will see additional information about that specific graphic. 

 

If you like shortcut keys then you can press TAB to indent or SHIFT+TAB 

to reverse indent. Character formatting, such as font, font size, bold, italic, 

and underline, can be applied to your text although it will not be visible in 

the text pane. When the font size in one shape shrinks because of too much 

text, the font size of all the other shapes will also shrink to the same size. 

In PowerPoint there is an additional command to help you quickly convert 

text to SmartArt (Home > Paragraph > Convert to SmartArt). The graphics 

are highly customisable. You can change and resize individual shapes, 

change fills, outlines and effects. The text that appears in your shapes is also highly customisable and includes a 

large style gallery. If you find your formatting has got a little bit too creative you can select (SmartArt Tools, 

Design Tab)(Reset Graphic) to remove all of your formatting changes and start over.
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Function - SUBTOTAL 
The arguments for this function are: SUBTOTAL(function_num, ref1, ref2 [,ref3]) 

function_num - 101 to 111 exclude rows hidden by Filtering, Manual Hiding and Grouping. 

function_num - 1 to 11 exclude rows hidden by Filtering. 

 

Rows can be hidden in a variety of different ways (filtering, manual 

hiding and grouping). The behaviour of this function with regards to 

hidden rows is somewhat confusing. The name of this function is also 

confusing because it can actually be used to calculate and return a 

variety of different functions (11 in fact). The most common ones are 

SUM, AVERAGE and COUNT. 

 

In cell “C2” insert this function using a function number of 9. This will 

return the sum of “C7:C13”. In cell “C3” insert this function with a 

function number of 1. This will return the average of “C7:C13”. In cell 

“C4” insert this function with a function number of 2. This will return 

the count of “C7:C13”. 

Filtering 

Let’s apply filtering “B6:C13” and let’s filter column “B” to only show 

Monday. You will notice that the results in C2, C3 and C4 have 

updated to ignore the two hidden rows. When data is filtered using a 

drop-down list any rows that are hidden will always be excluded. 

Manual Hiding 

Let’s now perform a similar action by manually hiding rows “8” and 

“9”. This time you will notice that cells C2, C3 and C4 have not 

updated. This is because when you use the function numbers 1 to 11, 

manually hidden rows are not excluded. Change the numbers in the 

subtotal functions to be 109, 101 and 102 respectively. Now the 

manually hidden rows are excluded from the subtotal function. 

Grouping 

Rows can also be hidden using a technique called grouping (or outlines). It is possible to group rows together so 

they can be quickly displayed or hidden. When rows are 

grouped a black line appears on the left hand side and a plus 

or minus sign will indicate if the rows are displayed or hidden. 

Before we create the two groups, insert a blank row below 

row 11. Select rows 7 to 11 and create a group for the 

Monday’s. Select rows 13 to 14 and create a group for the 

Tuesday’s. Close the Tuesday group to hide rows 13 and 14. 

The hidden rows are excluded from the subtotal functions. If 

you use the function numbers 1 to 11 rows hidden by 

grouping are not excluded. 

 

In 2010 the AGGREGATE function was introduced to replace 

this function. This function provides more clarity about the 

different methods of excluding rows and columns.
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Function – YIELD 

The arguments for this function are: YIELD(settlement, maturity, rate, pr, redemption, frequency [,basis]) 

This function returns the annual interest rate for a series of equal cash flows at regular intervals and often appears 

in financial models. It can be used to calculate the yield to maturity for a bond or in other words what the 

return/profit will be if you buy a bond and hold it to maturity. The yield to maturity of a bond is defined as the 

internal rate of return of all the cash flows, including the initial investment and final payment. 

 

Things to be aware of when using this function: 

 It always takes annual arguments and always returns an annual interest rate. 

 The interest rate is calculated on a compounding basis. 

 The compounding frequency is determined by the frequency of the coupon payments. 

 Any accrued interest is automatically included. 

 The yield can be calculated for any settlement date, including those between interest payment dates. 

Using RATE and IRR 

You might see the yield to maturity being calculated using the RATE or IRR functions. These functions can only 

calculate the yield to maturity on an interest payment date (not between interest payment dates). Most bonds 

pay a coupon semi-annually so the RATE and IRR functions will only give you the correct value if the settlement 

date falls on an interest payment date. 

 
Bond A – In this example the settlement date falls on an interest payment date with the bond maturing in exactly 

3 years. For this particular bond you could use either the RATE, IRR or YIELD functions to return the yield to 

maturity. Remember if you are calculating the yield to maturity on a bond with a semi-annual coupons the 

answer from the RATE and IRR functions have to be multiplied by 2 to give an annual interest rate. 

 

Bond B – In this example the settlement date still falls on an interest payment date with the bond maturing in 

exactly 3.5 years. For this particular bond you could use either the RATE, IRR or YIELD functions to return the 

yield to maturity. 

 

Bond C - In this example the settlement date falls between interest payment dates. For this particular bond only 

the YIELD function will give the correct yield to maturity. 
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Macro Security 
The Trust Center replaced the Security dialog box in 2007 and contains all the information relating to macro 

security. In 2013 this can be accessed from (File > Options > Trust Center). There was a “Trust all installed add-

ins and templates” checkbox in 2003 but this was replaced by trusted locations in 2007. All macros in trusted 

locations are always allowed to run and are excluded from the Trust Center security settings. 

 

These settings have always been a source of confusion and still are. First of all we think they are in the wrong 

order and second of all “without notification” should be added to the description shown below. Here is our 

summary of what the different options mean and notice that we describe them in a slightly different order to 

the order in which they appear on this dialog box. 

 

 
 

(1) Disable all macros without notification (Very High) All macros and security alerts are disabled. If there are 

any documents that contain unsigned macros that you want to use you need to put them into a trusted location. 

All macros, not in trusted locations are disabled (signed or unsigned). 

 

(2) Disable all macros (without notification) except digitally signed macros (High) In the screenshot above this 

is actually the third option. All macros are disabled except for those that have been digitally signed by a trusted 

publisher. You will only see a security alert when you open a document that has a digital signature that does not 

appear in your trusted publishers list. All unsigned macros are disabled without notification.  

 

(3) Disable all macros with notification (Medium) (Default) In the screenshot above this is actually the second 

option. A security alert is displayed every time you open any document containing macros (signed or unsigned). 

This lets you make the decision on a case by case basis. This is the default setting. 

 

(4) Enable all macros (Low) All macros are enabled and will run (signed or unsigned) and you will never see any 

security alerts. Using this setting is not recommended as it makes your computer vulnerable to potentially 

malicious code. 

 

Trust access to the VBA project object model (Default is off) This setting is for developers and is used to allow 

programmatic access to the VBA object model from any Automation client. For any Automation client to be 

able to access the VBA object model programmatically, the user running the code must explicitly grant access. 

This option was available in 2003 and has not changed. 

 

All macros in trusted locations are allowed to run regardless of your macro security setting. 

Each Office application has its own trust center/macro security settings. 


